## Contents

**Introduction** .................................................................................................................................................. 1

- Opening the sample database .................................................................................................................. 1
- Backing up the sample database ............................................................................................................. 2

**Customizing invoice and statement formats** ............................................................................................. 5

- Adding a new custom statement format .................................................................................................. 5
- Editing formats .......................................................................................................................................... 8
  - Formatting text and repositioning items ................................................................................................. 8
  - Adding a logo ......................................................................................................................................... 9
  - Previewing a statement ......................................................................................................................... 11
  - Adding additional text ......................................................................................................................... 13

**Customizing Report Formats** .................................................................................................................... 15

- Adding new custom report formats ...................................................................................................... 15
- Copying report formats .......................................................................................................................... 16
- Editing report formats ............................................................................................................................ 17
  - Adding and removing columns ........................................................................................................... 17
  - Moving columns .................................................................................................................................. 17
  - Inserting a column .............................................................................................................................. 20
  - Aligning items ..................................................................................................................................... 23
- Editing field properties ............................................................................................................................ 25
  - Changing the output format ................................................................................................................ 26
  - Changing font properties .................................................................................................................. 26
- Using formulas .......................................................................................................................................... 28
  - Preparing to add a new column .......................................................................................................... 28
  - Adding a formula ............................................................................................................................... 28
  - Creating an IF expression .................................................................................................................. 32
- Previewing report formats ........................................................................................................................ 35
- Printing custom reports .......................................................................................................................... 37
- Restoring defaults for standard reports .................................................................................................. 37
- Importing and exporting formats .......................................................................................................... 38
  - Exporting ............................................................................................................................................ 38
Importing ...................................................................................................................... 39
Practice CS Library ....................................................................................................... 39
Security ............................................................................................................................. 41

Additional Examples .............................................................................................. 45

Example: Removing a column from Billing Worksheet report........................................ 45
   Removing the Cost column ....................................................................................... 45
   Adjusting column spacing ....................................................................................... 49

Example: Adding comments to the Invoice Journal report ............................................. 52
   Adding a new report ................................................................................................. 52
   Adding new items to the report ............................................................................... 53
   Creating a PrintWhen condition .............................................................................. 55
   Previewing the report ............................................................................................... 58

Example: Adding a letter ............................................................................................. 60

Example: Adding a label ............................................................................................. 65

Example: Changing a report from landscape to portrait orientation ................................ 68
   Changing the page settings ....................................................................................... 68
   Adjusting the print area ........................................................................................... 69
   Adjusting other items .............................................................................................. 70

Example: Adding a custom chart ................................................................................. 72
   Adding a new pie chart ........................................................................................... 72
   Modifying the palette and labels ............................................................................ 74
   Adding a formula ...................................................................................................... 76
   Adding a chart title .................................................................................................. 78
   Axes and legends ..................................................................................................... 79
   Adding your chart to the report format .................................................................. 80
   Previewing and printing charts .............................................................................. 81

Restoring the sample database .................................................................................. 83
Introduction

This walkthrough introduces you to the processes involved in producing custom formats in Practice CS. After you have completed the walkthrough, you will be able to apply the custom formatting features of Practice CS.

Note: This walkthrough assumes you are familiar with using Practice CS or that you have read chapter 3, Program Overview, in the Practice CS Getting Started guide.

Opening the sample database

To perform the exercises in this walkthrough, you will start Practice CS and log in to the Sample database as staff CAT. To log in, follow these steps.

1. Start Practice CS.
2. In the Login dialog, select Sample in the Open Firm field.
3. In the Staff ID field, select CAT.

Note: If you previously marked the Remember login information checkbox, press and hold the SHIFT key as you double-click the Practice CS icon. Continue to hold the SHIFT key until the login dialog appears.
4. Click OK.

Back up the sample database

Data that you enter while performing the exercises in this walkthrough will affect the Sample database. Therefore, we recommend that you make a backup of the Sample database before you begin so that it is available for use in other Practice CS walkthroughs.

**Note:** If you are running Practice CS through the Virtual Office CS® module, the Backup menu command is not available. We recommend that you install a local copy of Practice CS so that you can back up the sample database. For instructions on installing the program, please see chapter 2, Installation Instructions, in the *Practice CS Getting Started* guide.

To back up the Sample database, follow these steps.

1. In Practice CS, choose File > Backup.
2. Click the button next to the Backup File field and if necessary, navigate to the folder where you want to save the backup file. The backup file will have a file extension of BDF.

*Note:* The backup file will be created on the computer where the data resides. The path specified here must be a valid path on that computer.

3. Click OK.

4. When prompted that the backup is complete, click OK.

*Note:* After you complete this walkthrough, you can restore the sample database. For instructions, see “Restoring the sample database” on page 83.
Customizing invoice and statement formats

The Practice CS Sample database comes with several predefined statement and invoice formats that you may use as setup suggestions. You can also use the powerful custom format editor to create your own. You can use the existing default format, create a new format based on an existing format, or create a new format from scratch.

Adding a new custom statement format

For this walkthrough, you will create a new statement format based on an existing one.

1. From the Setup menu, choose Custom Formats.
In the Custom Formats list, notice the existing formats for both invoices and statements. For this walkthrough, you will create a new format based on All Open Items Statement Format.

2. Right-click the All Open Items Statement Format and choose Copy Format.

A new format called **All Open Items Statement Format (2)** appears in the list.

3. Right-click All Open Items Statement Format (2) and choose Edit.

The format opens in the center pane. You may want to unpin the Custom Formats pane to better see the editing pane.

4. In the toolbar, click the Format Wizard button.

The Format Wizard opens. In this wizard, you can choose the information that appears in the statement format.
5. In the Main tab of the Format Wizard, enter **walkthrough** as the name of the new statement format.

6. Click the Next button to move to the Heading Information tab. Make no changes in this tab.

7. Click the Next button to move to the A/R Information tab. Make no changes in this tab.

8. Click the Next button to move to the Pay Stub Information tab. In this tab, unmark the *Client Phone Number* checkbox to remove the client’s phone number from the pay stub.

9. Click the Finish button to close the Format Wizard.
Editing formats

You can use the Custom Formats setup screen to customize invoice and statement formats to suit your firm’s needs. In the following exercises you will format text, move and align items, add a logo, and add additional text.

Formatting text and repositioning items

1. In the editing pane, scroll down to the pay stub at the bottom of the statement and click the “Amount Enclosed” text.

2. Click the Bold button \[B\] in the toolbar to make the text boldface.

3. The text box is now too small to contain the boldface text. Click and drag the handle at the center of the left side of the box toward the left, then release the mouse button. Repeat as necessary until the full text appears.

4. Click the “Amount Due” text above the “Amount Enclosed” text box, press and hold the SHIFT key, then click the “[AR” text box.

5. Click and drag the two items you selected until they are just above the “Amount Enclosed” text box.

6. Click the “Amount Enclosed” text box, press and hold the SHIFT key, then click the “Amount Due” text box.

7. Now that both boxes are selected, you can align them along their left edges by clicking the Align Lefts button \[\text{Align Lefts}\] in the toolbar.
8. With both boxes still selected, press the left arrow key on the keyboard multiple times to move them to the left and clear of the text boxes on the right.

9. Click the "[AR]" text box, press and hold the SHIFT key, then click the text box immediately below.

10. Click the Align Lefts button to align the selected text boxes.

Adding a logo

You can add a logo to a statement by marking the Logo checkbox in the Heading Information tab of the Format Wizard, but that restricts the image you insert to the header portion of the statement. The following method enables you to add a logo to any part of a statement.

For the current statement format, first we need to delete the old logo.

1. Click the colorful logo at the top of the statement format, then press the DELETE key.

2. Click the Image button on the toolbar. The cursor changes to crosshairs.

3. Click the location where you want the image to appear, hold down the left mouse button, and drag to create a box for the image. Release the mouse button when finished. You can move and resize this box later if necessary.
4. With the image box selected, click the **Image** field in the Properties pane.

5. Click the **Image** button in the **Image** field, navigate to the image file you want to add, and click **Open** to insert the image into the box you created. For this walkthrough, choose an image on your computer, preferably a simple one.

6. In most cases, the image will not properly fit the box you created. In the Properties pane, select **Zoom** in the **SizeMode** field. This zooms the image to fit within the box you created.
7. Move the image to its desired location.

**Tip:** To move an item in the format designer, you can either click and drag the item, or select it and press the arrow keys. Hold down the CTRL key and press the arrow keys to move the item in larger increments.

**Previewing a statement**

1. Click the Preview button in the toolbar to preview the statement and check the image’s size and positioning.

2. The Preview Custom Statement Format dialog enables you to choose a client for whom to preview the statement. Highlight the item for client AAC and click OK.

When the preview window appears, notice the changes you made to the format. The logo appears where you placed it.
3. Scroll down to the bottom and notice that the client phone number does not appear on the pay stub (a change you made in the Format Wizard), and the “Amount Enclosed” text is boldface and aligned with the text above it.

4. Close the preview window. Make additional changes to the format as necessary.
Adding additional text

You can add text to your statements by adding text boxes.

1. Click the Textbox button in the toolbar.

2. Click the location where you want the text box to appear, hold down the left mouse button, and drag to create a text box of the approximate size you need. Release the mouse button when finished. You can move and resize this text box later if necessary.

For this walkthrough, add a text box below the “Amount Enclosed” box at the bottom of the statement.

3. To edit the text, double-click the text box. You can also click within the OutputValue field in the Properties pane to activate the field. Then click the button next to that field to open the OutputValue Formula dialog.
4. In the OutputValue Formula dialog, enter **Thank you!** Click OK when finished.

5. Format the text using the toolbar. Change it to Times New Roman, 14 pt, bold, italic, and center-aligned.

6. Preview the statement and then move, resize, or reformat the text box as necessary.

7. Click the **Save** button in the toolbar to save your changes.

8. Click the **Close** button in the toolbar to close your custom statement format.
Customizing Report Formats

Practice CS enables you to create custom reports that present firm data the way you want to see it. Using a default Practice CS report as a starting point, you can choose the data you want reported and the format in which it should appear.

Additionally, you can export the custom report formats you create so they can be used for other databases. You can even share custom report formats with others in the profession, and download formats that others have shared.

The Custom Formats setup screen, which you may already have used to customize invoice and statement formats, provides the tools you will need to create your own custom reports.

This chapter provides information on creating, copying, and editing report formats, previewing and printing your customized formats, restoring defaults for standard reports, importing and exporting custom report formats, and security options for the Custom Formats setup screen.

Adding new custom report formats

Custom report formats are based on existing standard reports in Practice CS, though your flexibility in customizing those reports is virtually unlimited. For this walkthrough, add a new custom report following these steps.

1. Choose Setup > Custom Formats to open the Custom Formats setup screen.

2. Click the Add Document button on the toolbar and choose Add Report from the available commands. The Report Format Wizard opens.

4. In the list of Standard Reports on the left, expand the folder that contains the report on which you want to base your custom report, then select that report. For this example, base the new report on the Clients report under Lists.

5. Click Finish to close the Report Format Wizard and return to the Custom Formats screen with the report open in the format editor.

6. Click the Save button.

Copying report formats

If you want to base a new custom report on a report that you previously customized, you can create a copy of the previous report to serve as the basis for the new report.
1. In the list of reports in the Custom Formats screen, right-click My Report and choose Copy Format from the context menu.

   ![Custom Formats screen](image)

   This adds a new report to the list named **My Report (2)**.

2. Right-click the copy and choose Edit from the context menu. The report opens in the format editor. You can now click the Format Wizard button to change the name of the report, or begin customizing the report in the editor.

3. For this exercise, click the Close button on the toolbar.

---

**Editing report formats**

The format editor on the Custom Formats screen enables you to make numerous changes to report formats. You will use the custom report you added previously to explore these changes.

**Adding and removing columns**

One of the basic operations in customizing reports is to add and remove columns from a report. For this exercise, you will add a new column to the report you created earlier.

**Moving columns**

1. Right-click My Report in the list of reports and choose Edit from the context menu.

2. Unpin the list of reports. To do this, click the pin in the upper-right corner of the list pane. This enlarges your work area.
3. Click the button next to the ReportHeader section label to hide the ReportHeader section, which contains cover sheet information that we will not need for this exercise.

You will now move columns around to create room for a new column.

4. In the format editor, select the *Primary Address* text box in the PageHeader section.
5. While holding down the CTRL key, select the **Primary Phone** and **E-mail** boxes in the PageHeader section. Then, in the Detail section, select the three address boxes, the **Contact Phone phone** box, and the **Contact Email email** box, as shown in the illustration below.

![Illustration of report layout](image)

6. Press the right arrow key to move all of the boxes to the right. Open up enough space to insert a column to the left of the address.

Moving the columns also moved the right edge of the e-mail boxes out of the printable area of the report. Now you will temporarily expand the right margin and re-size the two affected boxes.

7. In the ruler at the top of the editor, position the mouse cursor so it becomes a double-sided arrow at the right margin, then click and drag the margin to the right until the ends of the e-mail boxes are shown.

![Illustration of margin adjustment](image)

**Note:** You may need to drag the margin a little, then use the horizontal scroll bar to scroll to the right, then drag a little more, and so on.

8. Click within the editor to deselect the boxes you selected previously, then select the **E-mail** box in the PageHeader section, press **SHIFT**, and select the **Contact Email email** box below it.
9. With the two boxes selected, hold the SHIFT key and press the left arrow key until the right edges of the boxes align with the original right margin, as shown below.

10. Drag the right margin back to its original position (10½ inches).

**Inserting a column**

Now you will insert a new column. For this exercise, you will add an **A/R Ending Balance** column to the report.

1. Click the Text Box button on the toolbar. The cursor becomes a crosshair.
2. Position the cursor in the PageHeader section at the upper-right corner of the Description text box, then click and drag to open a new text box between the Description and Primary Address boxes.
3. Double-click the new text box to open the OutputValue dialog.
4. In the text entry area at the bottom of the dialog, enter **A/R Ending Balance**. Then click OK to return to the editor.

5. With the A/R Ending Balance text box selected, click the Center button on the toolbar to center the text in the box.
6. In the Fields pane on the right side of the editor, expand the Client item. Then expand the A/R item beneath Client and the Aging item beneath A/R, as shown in the following illustration.

7. Click the Ending Balance item and drag it into the Detail section of the editor, positioning it beneath the A/R Ending Balance text box you just created.

8. Click the Font Size drop-down on the toolbar and change the font size to 8.

9. Click the Center button on the toolbar to center the text in the box.
Aligning items
Now you will need to align the boxes you added to their neighbors and to each other.

1. Select the A/R Ending Balance text box you added in the PageHeader section, then press SHIFT and select the Description box to its left.

2. Click the Align Tops button on the toolbar.

3. Click in empty space to deselect all boxes.

4. Align the Aging Ending Balance box you dragged to the Detail section with the box to its left using the same method. Deselect all boxes when finished.

5. Select the Aging Ending Balance box, then press SHIFT and select the A/R Ending Balance box in the PageHeader section.

6. Click the Make Same Size button on the toolbar.

7. Click the Align Lefts button on the toolbar.

8. Click the Preview button on the toolbar to see your changes, using the default report options. Close the preview window when finished.
Note: Certain Practice CS reports (for example, the Production Analysis report) let you include a Detail line 2 by marking the Display controls for Detail line 2 checkbox in the format wizard.

When both the first and second detail line controls are visible, as in the following illustration, you can tell them apart by clicking the control and looking at the RequiredOption property in the Fields pane.

Field properties are discussed further in the next section.
Customizing Report Formats

Editing field properties

The properties for various items included on reports are governed by the settings in the Properties pane to the right of the format editor. The properties that appear in this pane are arranged in the following categories:

- **General** — Includes the item’s name, height, width, and X and Y coordinates within its section of format editor.

- **Appearance** — Specifies attributes for alignment, transparency, font, and output format and value.

- **Behavior** — Governs whether the item can grow or shrink, allows multiple lines, is visible, or allows word wrapping.

- **Summary** — Governs the behavior of summary functions, including how subtotals are calculated and/or reset between sections.

- **Suppression** — Controls suppression of duplicates, printing, and final items under certain conditions.

Click an item to see a brief explanation of its purpose below the Properties pane.

*Note:* You can switch between categorized and alphabetical display of properties by clicking the Alphabetical button and Categorized button at the top of the pane.
Changing the output format
In this exercise, you will change output format for the field you added previously.

1. In the Detail section, select the *Aging Ending Balance* field from the previous exercise.

2. In the Properties pane, scroll down and select the OutputFormat item, then click the browse button that appears.

3. In the OutputFormatDialog, select Currency from the list of categories, then click OK.

Changing font properties
In this exercise, you will change the font of the main report heading.

1. Select the report title in the format editor.
2. In the Properties pane, select the Font item, then click the button that appears. This opens the Font dialog.

3. In the Font dialog, make the following selections:
   - Font — *Verdana*
   - Font style — *Bold*
   - Size — *14*

   Mark the *Underline* checkbox, then click OK.

   ![Font Dialog]

   The font for the report title has been changed to match your specifications, as shown below.

   ![Report Title]

4. Click the Preview button on the toolbar to see your changes, using the default report options. Close the preview window when finished.

   **Note:** The value in the field used for the preceding exercise, “List of [Plural Term(Client)],” reflects that this field contains an item that uses terminology that can be customized within Practice CS to match the terminology used by your firm. Terminology can be customized on the Terminology tab of the Firm setup screen.
Using formulas

Now you will add a field to the report that contains a calculated amount. Practice CS provides a formula editor for this purpose.

Preparing to add a new column

Before you add the new field, you will need to clear some space. First, delete the E-mail column.

1. Select the E-mail text box in the PageHeader section, then press SHIFT and select the Contact Email email box in the Detail section.
2. Press DELETE.

Next you will shift columns to the right to open space for the new column.

3. Select the Primary Address box, then press the CTRL key and select the Primary Phone box in the PageHeader section and the three address boxes and Contact Phone phone box in the Detail section.
4. Press the right arrow key until the phone boxes are flush with the right margin (10½ inches).

**Note:** Do not hold down SHIFT or CTRL for this step.

5. Click in blank space to deselect all selected items.

Adding a formula

Now you have space to add a new column. For this column, we need to create a custom formula.

1. In the Fields pane, right-click the Custom Formula item and choose Add Custom Formula from the context menu. This opens the Custom Formula dialog.
2. In the Description field, enter **Average Days to Collection**. This will display the average number of days between when you invoice a client and when they pay.

3. On the left side of the dialog, expand the Client, A/R, and Collection items until you see the Collect Day Count item, as shown in the following illustration.

4. Double-click Collect Day Count to add it to the formula.

5. Click the `/` button to create a division formula.

**Note:** When you click one of the operator buttons (add, subtract, multiply divide), you will not notice any change until you add another field. The formula will then be properly formatted with the operator between the two fields.
6. Double-click the Applied Count item from the list to add it to the formula. Check to see that your formula matches the one shown in the illustration.

```
[Client Collection Collect Day Count(Client, Report Date Period Start(0), Report Date) / Client Collection Applied Count(Client, Report Date Period Start(0), Report Date)]
```

7. Click OK to save the custom formula. It now appears as a sub-item beneath Custom Formula in the Fields pane.

8. Expand the Custom Formula item and drag the Average Days to Collection item onto the report in the Detail section, in the empty space you created earlier.

9. With the custom formula field still selected in the editor, scroll down the Properties pane to the OutputFormat item.

10. Click the button to open the Output Format dialog.

11. In the Decimal Places field, change the value to 0. Then click OK. This modifies the numeric output so that it shows integers only, with no decimal places.
If you need help with the final few tasks below, refer back to the earlier exercises in this guide.

12. Change the font size for the Average Days to Collection box to 8 pt.

13. Add a new text box to the PageHeader section to serve as a label for the new column. Enter Average Days to Collection in the text entry field for the text box.

14. Widen the upper Average Days to Collection box so it fills the available area between the neighboring columns.

15. Select the lower box, then press SHIFT and select the upper Average Days to Collection box.

16. Click the Make Same Size button on the toolbar.

17. Align the two new boxes with each other by left edges and with their neighbors by top edges.

18. Center the text in both boxes.

Note: If you make changes to a custom formula after you have already added a field that uses the formula to a report, you must replace the previously added field for the formula changes to be reflected.
Creating an IF expression
Practice CS makes it easy to create IF expressions to determine what to print under certain conditions. A simple example is to use an IF expression on My Report to print “n/a” when the client has no A/R ending balance.

1. On the My Report format, double-click the [Aging Ending Balance] text box in the Detail section to open the OutputValue Formula dialog.

2. If necessary, delete everything from the text field below the operator buttons.

3. Click the IF Expression tab below the text field.

4. In the left pane at the top of the dialog, click the expand buttons to expand the Client, A/R, and Aging items.
5. Drag the Ending Balance item to the first field in the *If condition* row.

6. Leave the = symbol selected in the *Operator* field.

7. In the last field of the *If condition* row, enter the numeral zero (0).

8. In the *Then print* field, enter n/a.
9. Drag the Ending Balance item (again) to the *Otherwise print* field.

You have now created an IF expression that says that if the client’s ending balance is equal to zero, print "n/a" on the report, but otherwise print the ending balance.

10. Click the Apply button.

11. Click OK to save the expression, then confirm that you want to save the formula.
12. Click the Preview button, leave the default options, and click OK to preview the report. Several clients with zero balances show “n/a” in the A/R Ending Balance column.

13. Close the preview window and click the Save button on the toolbar.

Previewing report formats

You can preview reports that you are customizing as you work on them. The previous exercise instructed you to preview the report at two separate points.

1. To preview a report as you work on it, click the Preview button on the toolbar.
Before the preview appears, you can modify report options in the Preview Custom Report Format dialog. This dialog offers the same tabs and fields as the Print Reports screen.

2. When the report options are set to your liking, click OK to see a preview of the report. For this walkthrough, leave the default options.

The preview opens in a separate window.
Customizing Report Formats

Notes

- If you keep the preview window open, you can make further changes to the report and click the Preview button again to refresh the preview using the same report options.
- You can click fields in the preview to drill down to other screens.
- If a red line appears down the right side of the report preview, the page width is too wide. Adjust the printable area by dragging left on right margin of the ruler.

Printing custom reports

When you save a custom report format for the first time, it is added to the list of reports in the Print Reports screen, in the same category as the standard report on which it was based.

You can print custom reports just like any other report, and can add them to report profiles.

Note: You can also print custom reports directly from the Custom Formats screen by previewing the report and then clicking the Print button on the toolbar of the preview window.

Restoring defaults for standard reports

If you have customized a standard report format and decide later that you want to revert to the defaults for that report, you can easily do so. Customized standard reports can be identified by the different icon that appears next to them in the list of reports. ✅

To restore defaults for a standard report, follow these steps. For this walkthrough you added a new report, so you should not need to perform this procedure now, but it is included here for your information.

1. In the Custom Formats screen, right-click the report and choose Edit from the context menu. The report opens in the editor.
2. Right-click the report again and choose Restore Default from the context menu.

Note: The Restore Default command is only available for standard reports that have been customized and that are open in the format editor.

3. Click the Save button ✅ on the toolbar.
Importing and exporting formats

You can export the custom formats you create so they can be used in other firm databases. Exported formats can then be imported for use.

Exporting

In this exercise, you will export the report we created earlier.

2. Click the buttons to expand the Reports item and the Lists item beneath it.
4. At the top of the screen, mark the File checkbox. This will export the format as a file, to be saved in a location of your choosing.
5. Click the button on the right end of the field.
6. In the Browse For Folder dialog, navigate to the location where you want to save the custom format. For this exercise, choose your computer’s Desktop and click OK.
7. Click the Export Selected button. Your custom format is exported as a file with an extension of .cfx.
8. Click OK to dismiss the confirmation dialog.

Note: If you want to send the custom format as an attachment to an e-mail message, mark the E-mail checkbox and click the button next to the field. You can then select recipients, and when you click the Export Selected button a message will be sent with the custom format as an attached file.
Importing

If there are custom formats available to import, you can pull them into Practice CS using the Import Custom Formats feature.

Follow these steps to import a custom format.


2. Click the button next to the Import Source field.

3. In the dialog that opens, navigate to your computer’s Desktop and click OK.

4. In the Import Custom Formats dialog, mark the checkbox for My Report.cfx

5. To import the format, you would click the Import Selected button, but for this exercise click Cancel.

Practice CS Library

A Practice CS Library portlet is available for all dashboards. This portlet enables you to download custom formats created by others in the industry or additional formats created by our Development staff. You can also submit your own custom formats for consideration.

To add this portlet to any dashboard, follow these steps.

1. Open the dashboard where you want to add the portlet.

2. Click the Select Portlets link in the upper right corner.

3. In the Select Portlets dialog, mark the Practice CS Library checkbox, and click OK.

Note: You may need to resize the portlet to view the information. Click and drag the edge of the portlet to resize as necessary.
4. Click the **Custom Formats** link at the top of the portlet.

Hover your mouse pointer over the name of a report (or click a name) to see a report description and some basic instructions.

Click the title of a report to see a sample. If the report looks like one you would like to use, click the Import icon to add it to your list of available reports in Practice CS. Imported reports are added to the appropriate report groupings and are available on the Print Reports screen as well as the Custom Formats screen.
Security

If your firm uses the security features of Practice CS to establish security groups with different levels of access to program features, you can grant or deny access to the Custom Formats setup screen by security group. You can also control access by type of report (e.g., invoices, statements, reports, labels & letters), or by individual report.

1. To set options for firm security, choose Setup > Security Groups.

   **Note:** This command is not available unless you have marked the *Enable Firm Security* checkbox in Setup > Firm > Preferences.

2. Select the Time Entry security group and click the Edit button.

3. Click the buttons to expand the Practice CS, Menu, and Setup Menu items.

4. Click the Edit button in the lower left corner.

5. Mark the *Custom Formats* checkbox under Setup Menu.

You just granted access to the Custom Formats screen, and as you can see in the right pane, this also granted access to all custom formats data. However, for this example you want to restrict access to only custom formats for reports. To do so, you must modify security settings for custom formats data.
1. In the left pane, click the collapse button to collapse the Menu item, then click the expand buttons to expand the Data and Custom Format Data items.

2. Clear the Invoices, Statements, and Labels & Letters checkboxes. Notice that each time you clear a checkbox, the right pane shows you the effects of your last change.

Though you have now granted access to report-related custom formats, the reports that appear on that screen for members of the security group are determined by security settings for the Print Reports screen.

For access to a report in the Custom Formats screen, a security group must first be granted privileges to print that report.

1. Collapse the Data section and click the buttons to expand the Menu, File Menu, and Print Reports items.

2. Expand the Collection item under Print Reports.
3. Mark the checkboxes for the *Accounts Receivable Ledger* and *Accounts Receivable Summary* reports.

You granted the security group privileges to print only two of the Collection reports. You can see that in addition to the two Collection reports, this group has printing privileges for some of the List reports (a checkmark would indicate access to all Lists, while a square denotes only partial access).

Though this security group has been granted access to Reports in the Custom Formats screen, it will only be able to customize the reports for which it has been given specific printing privileges: in this case, some of the Lists, and the Accounts Receivable Ledger and Accounts Receivable Summary.

- For this exercise, click Cancel to discard your changes.

**Note:** When a staff member creates a custom report in the Custom Formats screen, all members of that person’s security group are given access to print and customize the new report. If the staff member belongs to more than one security group, only the groups that previously had access to the report on which the new report was based will have privileges for the new report.
Additional Examples

This chapter offers a few examples that will take you through the customization process to create new reports. The exercises in the previous chapter familiarized you with customizing a listing report by adding and removing fields, editing field properties, and creating a formula. The following examples build upon those basic skills.

Example: Removing a column from Billing Worksheet report

Some firms may wish to remove the cost information from the Billing Worksheet report, because of what this information might reveal. In this exercise, you will remove the column and adjust the positioning of the remaining columns.

Removing the Cost column

1. Choose Setup > Custom Formats to open the Custom Formats screen.
2. Expand the Reports item and then expand the Billing item.
3. Double-click Billing Worksheet to open that report in the format editor.

4. Click the Preview button  to see where the Cost column is situated on the report.

5. Leave the default options selected in the Preview Standard Report Format dialog and click OK. The report opens in a preview window. Locate the Cost column.
6. Close the preview window. In the format editor, select the text box labeled Cost in the GroupHeader3B section.

7. Press the SHIFT key and select the fields directly below the Cost text box in the GroupHeader3C, Detail, GroupFooter6, GroupFooter5, GroupFooter4, and GroupFooter3B sections, as shown below.

Note: Cost-related fields appear in multiple report sections despite not appearing in the report preview you generated. The additional sections are used when one or more groupings are selected prior to printing the report.

8. Leave the items selected and scroll to the bottom of the report.
9. Press SHIFT again and select the remaining three cost-related fields, which are in the GroupFooter2, GroupFooter1, and ReportFooter sections. Skip the items in the GroupFooter3A section.

10. Press the DELETE key.

**Note:** If you are unsure whether you are selecting the right fields, you can double-click a field to open a dialog that displays the formula. The cost-related fields all include “Cost” in their formulas.

You can also select a field, scroll down to the OutputValue item in the Properties pane, and hover the mouse pointer over the value for that item. A tooltip appears showing the formula, which includes the word “Cost.”
Adjusting column spacing

Now that you have removed the Cost column, you may want to close up the space it left behind. Preview the report again to see how it looks with the column removed.

There is now considerable space between the Hrs/Units column and the Amount column. You will close up that space.

1. Close the preview window.

2. In the format editor, select the Amount box in the GroupHeader3B section, press SHIFT, and select the items directly beneath it in the same sections as before, skipping the GroupFooter3A section.

3. With the Amount column still selected, use the bottom scrollbar to scroll to the right edge of the report.
4. Press SHIFT and select the *Bill Amount* and *Comment / Biller Note (Biller:)* boxes in the GroupHeader3B section and any items beneath them, skipping the GroupFooter3A section as well as the PageFooter section. You should now have three columns selected.

*Note:* Do not select the lines in the GroupFooter sections, if possible. If you do move them, you can resize them later.

5. Press the left arrow key several times to move all selected items to the left.

6. Click in blank space to deselect all items, then select the two comment items on the right.

7. Press SHIFT and the right arrow key to extend the right edges of the selected items to the margin.
8. Preview the report.

![Billing Worksheet]

9. Close the preview window.

10. If necessary, resize the lines around the subtotals in the GroupFooter sections. You can select multiple lines and resize them simultaneously. With lines selected, press SHIFT and the right or left arrow key to resize the lines.

With some trial and error, you can get the report to look the way you want it.

11. Click the Save button on the toolbar. This saves the customized standard report and changes the icon for it to indicate that it has been modified.

Note: The report you just customized is already available in the Practice CS Library portlet. Add the portlet to any dashboard, then scroll to the Billing reports and click the icon to import The Billing Worksheet – No Cost report.
Additional Examples

12. Right-click Billing Worksheet in the list of reports and choose Restore Default from the context menu, then click the Save button. This discards the changes you made in this exercise and reverts to the default version of the report.


Example: Adding comments to the Invoice Journal report

In this example, you will add a comment line to the Invoice Journal report, which will print only when text has been entered in the Comment field in Time & Expense Entry.

Adding a new report


2. In the Report Format Wizard dialog, enter Invoice Journal with comments in the first field.
3. Expand the Billing folder in the list of standard reports and click the Invoice Journal.

![Image of Report Format Wizard]

4. Click Finish to close the Format Wizard and open the new report in the format editor.

### Adding new items to the report

1. Click the InvoiceDetail tab at the bottom of the screen.

![Image of InvoiceDetail tab]

2. Hover the mouse pointer over the bottom of the Detail section until it turns into a double arrow, then click and drag the bottom boundary to open more space in the Detail section.

![Image of InvoiceDetail section with Dragged Boundary]

3. Click the Text Box button on the toolbar.
4. Click beneath the existing items in the Detail section and open a new text box, as shown below.

5. Double-click the text box you just added.

6. In the OutputValue Formula dialog, enter **Comment:** in the text area at the bottom.

7. Click OK to close the dialog. The text box now contains the text you entered in the previous step.

8. With the text box still selected, click the **Bold** button on the toolbar.
9. Resize the text box to fit the text and click the Align Rights button on the toolbar.

![Invoice Journal with comments diagram](image)

10. In the Fields pane, click the button to expand the Invoice Detail item, then scroll down and expand the Time/Expense Entry item.

11. Scroll down to the comments item. Click and drag that item to the report, to the right of the text box you created.

![Fields pane with Comment item](image)

12. Resize the item so its right edge extends to approximately nine inches on the ruler.

13. Press SHIFT and select the other text box you added, then click the Align Tops button on the toolbar.

### Creating a PrintWhen condition

Now that you have added the new Comment item to the report, you can specify the condition under which the item prints, which in this case is any time text exists in the Comment field on the Time & Expense Entry screen. To completely suppress printing of the item when no text is present, you must apply the same condition to both text boxes. If you apply the condition only to the Time/Expense Entry comment box, the Comment: box will still print.

1. You can only apply the PrintWhen condition to one item at a time, so click in blank space to deselect all items.

2. Select the Comment: box.
3. In the Properties pane, scroll down and click the *PrintWhen* property in the *Suppression* group.

![PrintWhen property in Properties pane](image)

4. Click the **button in the *PrintWhen* field.

5. In the Print When Formula dialog, expand the Invoice Detail item, scroll down the list and expand the Time/Expense Entry item, then scroll down further and double-click the comments item.
6. Place the cursor to the left of the far right square bracket, press the space bar, and enter the following:

```<>""
```

Because that may be hard to read, here is the sequence of keystrokes:

`left angle bracket | right angle bracket | space | double quotation marks | double quotation marks`

The formula should now match this text:

```
[Sheet Entry comment(Billing Decision sheet entry(Billing Decision)) <> ""
```

This tells Practice CS to print the contents of the text box when the comment field is not empty.

7. Click OK.

8. Select the Time/Expense Entry comment box and repeat this procedure starting at step 3.

9. After you have set the PrintWhen condition for both items, click the Save button on the toolbar.
Previewing the report

1. Click the Preview button on the toolbar.

2. On the Selection tab, select Custom in the Report date field and 12/31/2013 in the date field.
3. Click the Layout tab and mark the *Include Invoice Detail* checkbox.

![Preview Custom Report Format](image)

4. Click OK, then use the navigation buttons at the top of the screen to scroll through the report. Notice that the report includes the Comment line for some items, but not for others.
5. Close the preview window.

6. Click the Close button on the toolbar. If prompted, click Yes to save your changes.

---

**Example: Adding a letter**

In addition to custom report formats, the format editor enables you to create custom letters that use data from Practice CS. In this example, you will create a simple letter informing clients of their current balances.

1. Click the Add Document button in the toolbar and choose Add Label/Letter.

2. In the Label/Letter Format Wizard dialog, enter *My Letter* in the first field.
3. In the list of standard labels and letters, expand the Letters folder and click Client Letter.

4. Leave Client selected in the Label/Letter type field and click Finish. The letter opens in the format editor.
Note: The Label/Letter type field governs the sort of contact for whom the label or letter can be printed. The available types are Client, Contact, Firm, Staff, and Office. For example, a label of type Client can be printed for your firm’s clients, while a label of type Contact can be printed for any of your firm’s contacts, regardless of any client affiliations.
5. Double-click the text box containing the body of the letter (below the salutation). The OutputValue Formula dialog opens with the text displayed.

![Output Value Formula dialog](image)

6. Delete all of the default text and replace it with the following:

   **This letter is to inform you of your current balance, per your request. We have calculated the amount to be $**

   **Notes**
   - You can copy text from other software and paste it into the text area.
   - The dollar sign you included in this step will appear before the balance figure, which you will now add using a formula.

7. In the left pane above the text area, expand the Client, A/R, and Aging items.
8. Double-click the Ending Balance item. Practice CS inserts a formula into the text field.

9. Add a period immediately after the formula, then press CTRL+ENTER twice to add new lines, and add a closing:

   Sincerely,

**Note:** To add new lines, you must press CTRL+ENTER instead of ENTER.

10. Click OK.
11. Click the Preview button on the toolbar. Leave the default options selected and click OK.

![Preview Custom Letter Format](image)

**Notes**

- Formulas can be added to regular text boxes but not to rich text boxes.
- Rich text boxes provide more control over formatting. For example, you can use boldface or italics on individual words or characters. In a regular text box, any formatting applies to all of the text.

12. Close the preview window and click the Save button on the toolbar.

13. Click the Close button to close the letter.

**Example: Adding a label**

The format editor provides you the flexibility to customize the labels that you print from Practice CS. In this example, you will create a new label format for three-column printing.

1. In the list of custom formats, expand the Labels & Letters folder and the Address Labels subfolder.
2. Double-click the last label, *Client – 8161 – 1” x 4”*. The label opens in the format editor.

3. Click the Detail line in the editor.

4. In the Properties pane, change the ColumnCount property from 2 to 3 and press ENTER.

Notice that the white printable area shrinks.

5. Select the Contact name text box, then press SHIFT and select the remaining four text boxes.
6. With the boxes selected, hold down the SHIFT key and press the left arrow key several times until the right-hand boundary of the boxes fits within the printable area.

7. Click the Preview button in the toolbar. Accept the default options and click OK.
Notice that the labels now print across three columns. You can use the format editor to customize your labels to fit odd-sized label formats.

8. Close the preview window.

9. Click the Close button on the toolbar. When prompted to save changes, click No.

Example: Changing a report from landscape to portrait orientation

If your firm decides to add columns to a portrait-orientation report, you may find it useful to switch the orientation of the report to landscape. There may also be reports that you want to change from landscape to portrait after removing columns.

The Custom Reports screen in Practice CS can accommodate such changes. In this exercise, you will transform the Service Charge Journal report from portrait to landscape orientation.

Changing the page settings

1. Open the custom formats screen (Setup > Custom Formats).
2. Expand the Reports item and then expand the Collection item.
3. Double-click Service Charge Journal to open that report in the format editor.

![Report Settings dialog]

*Note:* The Page Setup command is only available in the File menu when a report or other item is being edited in the Custom Formats screen.
5. In the Report Settings dialog, click the Printer Settings button.

6. In the Orientation box, click the Landscape option, then click OK.

---

### Adjusting the print area

Now that you have changed the page settings, you can widen the print area of the report to accommodate additional columns.

1. Use the horizontal scroll bar to scroll to the right edge of the report. Notice that the ruler at the top of the editor shows the print area to be eight inches wide.

   ![Ruler Showing Print Area](image)

   Eight inches of print area for an 8½-inch-wide, portrait-orientation report indicate that the report has ¼-inch margins on the left and right. If we use the same margins for the landscape-orientation report, the print area should be 10½ inches wide.

2. Hover the mouse pointer over the right edge of the report until it turns into a double-sided arrow.

3. Click and drag the right edge of the report from 8 to 10½, as indicated by the top ruler, then release the mouse button.

---

### Notes

- You may need to drag the margin a little, then use the horizontal scroll bar to scroll to the right, then drag a little more, and so on.
You can also change the print width by entering a value in the Print Width field of the Properties pane in the General section.

The report now has 10½ inches of lateral print area, giving you room to add more columns. Now you can move the last few columns to the right to open up space in the middle of the report, or add new columns on the right.

Adjusting other items

When you changed the size of your print area, you also moved the center of your report, and items that were centered on the portrait-orientation version are now off-center. Similarly, any horizontal lines that separated areas of the previous report may no longer extend all the way to the right margin. In this part of the example, you will move and re-size these items to accommodate the wider print area.

1. The first items to adjust are the gray horizontal lines that separate sections of the report. Select the top line in the PageHeader section.

2. Press SHIFT and select the other line in the PageHeader section.

3. Scroll down until you can see the gray line in the PageFooter section, and with SHIFT still pressed, select that line.

4. With the lines still selected, press and hold the SHIFT and right arrow keys until all three lines reach the edge of the print area.
5. Click in blank space to deselect all items.

6. Scroll back toward the left and up until you can see the top of the PageHeader section and the two text boxes that make up the report’s header. Select the top text box.

7. Press SHIFT and select the other text box.

8. Choose Format > Center in Form > Horizontally. The selected text boxes are now centered for the widened report.

9. Click the Preview button on the toolbar, choose Prior Period End Date in the Report date field, then click OK.
The preview enables you to see which items still need to be moved. You can see from the placement of the fields on the right how much space you gained by changing the report’s orientation.

10. Close the preview window and click the Save button on the toolbar to save the customized report. If necessary, you can revert to the default version as you did in the Billing Worksheet example.

Example: Adding a custom chart

Practice CS enables you to add custom charts and graphs featuring data relevant to the selected report. Use the Chart Wizard to create a new chart, pull data from the program, configure the chart or graph to appear the way you want it, and modify the titles, labels, and legend.

For this exercise, we will add a pie chart to a copy of the Production Analysis report. The chart will show the firm’s margin for the period, grouped by client entity.

Adding a new pie chart

1. In the list of reports in the Custom Formats screen, expand the Production folder.

2. Right-click the Production Analysis report and choose Copy Format from the context menu.
3. Double-click the Production Analysis (2) report to open it in the formatter.

4. Scroll down to the ReportFooter section, select the existing chart, and press the DELETE key to remove it from the report format.

5. In the Fields pane, right-click the Custom Chart item and choose Add Custom Chart from the context menu.

6. In the Chart Type tab of the Chart Wizard, select Pie/Doughnut from the Chart Group drop-down list, then select the Pie chart in the 3D subtab.

7. In the Description field at the bottom of the tab, enter Margin, then click Next.
Modifying the palette and labels

Now we’ll change the color palette for the chart and add labels that help identify the data in the chart. By default, these labels are surrounded by boxes, but we want to remove these boxes.

1. From the list in the Palette subtab, select the Springtime palette.

2. Click the Appearance subtab, click the representation of the pie chart to select it, then unmark the Use default (none) checkbox for the Marker item.

3. Click the Drill down link next to the checkbox you just unmarked.

4. Click the Drill down link for the Label item.

5. Click the second drop-down list for the Border item and select (none).
6. Click the representation of the pie chart to return to the top level of the Appearance subtab.

7. Click the **Drill down** link for the Marker item (again).

8. Click the second drop-down list for the Line item and select (none). This finally removes the boxes around the chart labels.

9. Click Next to continue.
### Adding a formula

The next step in creating a chart is to add data. For this example, we need to construct a formula that subtracts cost from billable amount. The difference is the margin realized by the firm.

1. In the Chart Data tab, mark the *Use group descriptions* checkbox. This tells Practice CS to use the descriptions from the chart grouping in the chart’s legend. For this report, we will group by client entity, so the various client entity descriptions will be used in the legend.

2. In the Series box, highlight *Amount2* and click the Delete button \( \times \) to remove it. Do the same for *Amount3*.

3. Click the Chart Series Formula Editor button to open the Chart Series Formulas dialog. You may recognize this dialog, because it’s the same as the one used to add formulas to reports and other formats.

4. In the left pane at the top of the Chart Series Formulas dialog, expand the Production And Billing Posted item and double-click the *billable amount* item to add it to the formula.
5. Click the “minus” operator button. 

\[ - \]
6. Scroll down further in the left pane and double-click the **production units cost** item to complete the formula.

![Chart Series Formulas](chart-series-formulas.png)

7. Click OK to close the Chart Series Formulas dialog and return to the Chart Wizard. Then click Next to continue.

**Adding a chart title**

The next step is to add a title that will appear above the chart. The title is hidden by default; we will make it visible, change the default text, and format the new title.
1. In the Titles tab, verify that header is selected in the Titles box.

2. Mark the Visible checkbox.

3. In the Title properties box, delete the default text (Chart Title) in the text field and enter Margin to replace it.

4. Change the font to Arial and click the bold and underline buttons. This changes the title to bolded Arial that is not underlined (the default title was underlined).

5. Click Next to continue.

**Axes and legends**

The Axes tab is more applicable to other kinds of charts (such as bar graphs). Use the Axes tab to format the X and Y axes for the chart, including labels, tick marks, grid lines, and font format.

Use the Legend tab to format the chart’s legend, including font formatting and the position and layout of the legend. For this exercise, we will modify the header text for the legend.

1. Click Next until the Legend tab is shown.

2. In the Header and Footer box, delete the default text (Legend) from the top text field and enter Groupings in its place.
3. Change the top font size to 10 and click the bold button.

4. Click the Finish button to save the custom chart.

**Adding your chart to the report format**

Now that you have created a custom chart, you can add it to any relevant report.

1. With the *Copy of Production Analysis* still open in the formatter, click and drag the new Margin custom chart from the Fields pane into the ReportFooter section.
2. Click and drag a corner of the chart to fill more of the empty space in the ReportFooter section.

3. Click the Save button to save the report format.

Previewing and printing charts

When you preview or print a format that includes a chart, you must enable the chart in the layout options or it will not appear in the ReportFooter.

1. With the Copy of Production Analysis still open in the formatter, click the Preview button on the toolbar.
2. In the Preview Custom Report Format dialog, click the Layout tab.
3. In the Detail by field, select Client Entity.
4. Mark the *Print Charts* checkbox.

5. Click OK to preview the report with the chart included.

6. Close the preview window.
Restoring the sample database

After you have completed this walkthrough, you should restore the sample database that you backed up (see "Back up the sample database" on page 2). Use the restored sample database to complete other Practice CS walkthroughs.

1. From the File menu, choose Restore.

2. In the Restore dialog, enter the path to the backup file that you want to restore, or click the button to navigate to the backup location (typically X:\Program Files\Microsoft SQL Server MSSQL$CREATIVESOLUTION\Data, where X: is the drive on the computer where the data resides).

3. In the Restore File Location dialog, click the backup file that you want to restore and click OK.

4. In the Restore dialog, enter a new name for the database in the New Firm name field.

Note: When you restore the Sample database, you must give it a different name. The restore process in Practice CS does not overwrite an existing database, and Practice CS does not allow firm databases with duplicate names. Therefore, you will need to give the database a different name when you restore it (for example, Sample1). The name may contain only alphanumeric characters.